
GEORGIA INSTITUTE OF TECHNOLOGY
SCHOOL of ELECTRICAL and COMPUTER ENGINEERING

ECE 2025 Spring 2005
Lab #2: Introduction to Complex Exponentials

Date: 25–31 Jan. 2005

You should read the Pre-Lab section of the lab and do all the exercises in the Pre-Lab section before
your assigned lab time.

The Warm-up section of each lab must be completed during your assigned Lab time and the steps marked
Instructor Verification must also be signed off during the lab time. One of the laboratory instructors must
verify the appropriate steps by signing on the Instructor Verification line. When you have completed a
step that requires verification, simply raise your hand and demonstrate the step to the TA or instructor. After
completing the warm-up section, turn in the verification sheet to your TA.

It is only necessary to turn in Section 4 as the lab report for this lab. More information on the lab report
format can be found on Web-CT under the ‘Information” link. You are asked to label the axes of your plots
and include a title for every plot. In order to reduce missing plots, include your plot as a figure embedded
within your report. For more information on how to include figures and plots from MATLAB in your report
file, consult the “information” link on Web-CT. If you still do not know how to do so, ask your TA.

Forgeries and plagiarism are a violation of the honor code and will be referred to the Dean of Students
for disciplinary action. You are allowed to discuss lab exercises with other students and you are allowed to
consult old lab reports, but you cannot give or receive written material or electronic files. Your submitted
work should be original and it should be your own work.

Due Date: The lab report will be due during the period 1-Feb. through 7-Feb. at the start of your lab.

PRINTING BUDGET: For the printers in the ECE labs, you have a quota. Please limit your print-
ing to essential items for the labs. If you need to print lecture slides and other large documents,
use the central (OIT) printing facilities.

1 Introduction and Overview

The goal of this laboratory is to gain familiarity with complex numbers and their use in representing sinu-
soidal signals such as x(t) = A cos(ωt + ϕ) as complex exponentials z(t) = Ae jϕe jωt . The key is to use
the complex amplitude and then the real part operator applied to Euler’s formula:

x(t) = A cos(ωt + ϕ) = <e{Ae jϕe jωt
}

Manipulating sinusoidal functions using complex exponentials turns trigonometric problems into simple
arithmetic and algebra. In this lab, we first review the complex exponential signal and the phasor addition
property needed for adding cosine waves. Then we will use MATLAB to make plots of phasor diagrams that
show the vector addition needed when combining sinusoids.

1.1 Complex Numbers in MATLAB

MATLAB can be used to compute complex-valued formulas and also to display the results as vector or
“phasor” diagrams. For this purpose several new MATLAB functions have been written and are available
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on the SP First CD-ROM. Make sure that this toolbox has been installed1 by doing help on the new M-

nkht
CD-ROM

SP First
MATLAB
Toolbox

files: zvect, zcat, ucplot, zcoords, and zprint. Each of these functions can plot (or print) several
complex numbers at once, when the input is formed into a vector of complex numbers. For example, try the
following function call and observe that it will plot five vectors all on one graph:

zvect( [ 1+j, j, 3-4*j, exp(j*pi), exp(2j*pi/3) ] )

Here are some of MATLAB’s complex number operators:

conj Complex conjugate

abs Magnitude

angle Angle (or phase) in radians

real Real part

imag Imaginary part

i,j pre-defined as
√

−1

x = 3 + 4i i suffix defines imaginary constant (same for j suffix)

exp(j*theta) Function for the complex exponential e jθ

Each of these functions takes a vector (or matrix) as its input argument and operates on each element of the
vector. Notice that the function names mag() and phase() do not exist in MATLAB.2

Finally, there is a complex numbers drill program called:

nkht
CD-ROM

Z Drill

zdrill

which uses a GUI to generate complex number problems and check your answers. Please spend some time
with this drill since it is very useful in helping you to get a feel for complex arithmetic.

When unsure about a command, use help.

1.2 Sinusoid Addition Using Complex Exponentials

Recall that sinusoids may be expressed as the real part of a complex exponential:

x(t) = A cos (2π f0t + ϕ) = <e
{

Ae jϕe j2π f0t
}

(1)

The Phasor Addition Rule presented in Section 2.6.2 of the text shows how to add several sinusoids:

x(t) =

N∑
k=1

Ak cos(2π f0t + ϕk) (2)

assuming that each sinusoid in the sum has the same frequency, f0. This sum is difficult to simplify using
trigonometric identities, but it reduces to an algebraic sum of complex numbers when solved using complex
exponentials. If we represent each sinusoid with its complex amplitude

Xk = Ake jϕk (3)

1Correct installation means that the spfirst directory will be on the MATLAB path. Try help path if you need more
information.

2In the latest release of MATLAB a function called phase() is defined in a seldom used toolbox; it does more or less the same
thing as angle() but also attempts to add multiples of 2π when processing a vector.
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Then the complex amplitude of the sum is

Xs =

N∑
k=1

Xk = Ase jϕs (4)

Based on this complex number manipulation, the Phasor Addition Rule implies that the amplitude and phase
of x(t) in equation (2) are As and ϕs , so

x(t) = As cos(2π f0t + ϕs) (5)

We see that the sum signal x(t) in (2) and (5) is a single sinusoid that still has the same frequency, f0, and it
is periodic with period T0 = 1/ f0.

1.3 Harmonic Sinusoids

There is an important extension where x(t) is the sum of N cosine waves whose frequencies ( fk) are dif-
ferent. If we concentrate on the case where the frequencies ( fk) are all multiples of one basic frequency f0,
i.e.,

fk = k f0 (HARMONIC FREQUENCIES)

then the sum of N cosine waves given by (2) becomes

xh(t) =

N∑
k=1

Ak cos(2πk f0t + ϕk) = <e

{
N∑

k=1

Xk e j2πk f0t
}

(6)

This particular signal xh(t) has the property that it is also periodic with period T0 = 1/ f0, because each of
the cosines in the sum repeats with period T0. The frequency f0 is called the fundamental frequency, and
T0 is called the fundamental period. (Unlike the single frequency case, there is no phasor addition theorem
here to combine the harmonic sinusoids.)

2 Pre-Lab

Please do the exercises in this section prior to coming to lab.

2.1 Complex Numbers

This section will test your understanding of complex numbers when plotted as vectors. Use z1 = 2e jπ/4 and
z2 = −

√
3 + j for all parts of this section.

(a) Enter the complex numbers z1 and z2 in MATLAB and plot them with zvect(), and print them with
zprint().

When unsure about a command, use help.

Whenever you make a plot with zvect() or zcat(), it is helpful to provide axes for reference. An
x-y axis and the unit circle can be superimposed on your zvect() plot by doing the following:
hold on, zcoords, ucplot, hold off

(b) Compute the conjugate z∗ and the inverse 1/z for both z1 and z2 and plot the results as vectors. In
MATLAB, see help conj. Display the results numerically with zprint.
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(c) The function zcat() can be used to plot vectors in a “head-to-tail” format. Execute the statement
zcat([1+j,-2+j,1-2j]); to see how zcat() works when its input is a vector of complex
numbers.

(d) Compute z1 + z2 and plot the sum using zvect(). Then use zcat() to plot z1 and z2 as 2 vectors
head-to-tail, thus illustrating the vector sum. Use hold on to put all 3 vectors on the same plot.
If you want to see the numerical value of the sum, use zprint() to display it.

(e) Compute z1z2 and z2/z1 and plot the answers using zvect() to show how the angles of z1 and z2

determine the angles of the product and quotient. Use zprint() to display the results numerically.

(f) Make a 2 × 2 subplot that displays four plots in one window: similar to the four operations done
previously: (i) z1, z2, and the sum z1 + z2 on a single plot; (ii) z2 and z∗

2 on the same plot; (iii) z1 and
1/z1 on the same plot; and (iv) z1z2. Add a unit circle and x-y axis to each plot for reference.

2.2 Z-Drill

Work a few problems generated by the complex number drill program. To start the program simply type
zdrill (if necessary, install the GUI and add zdrill to MATLAB’s path). Use the buttons on the graph-
ical user interface (GUI) to produce different problems.

2.3 The Notebook Option

The purpose of this section is to introduce you to the notebook capability that links MATLAB and Microsoft
Word under Windows. This option allows you to execute MATLAB commands, scripts and functions from
inside a Microsoft Word document and then have results (including graphs) displayed automatically inside
that same MS-Word document. This should make it easy to create lab reports by reducing the problems (and
pain) associated with importing figures and results into MS-Word. You are not required to use this feature
to write your lab reports, but many students find it useful.3

Note that GUI items such as zdrill will not work from inside MS-Word. Also note that MATLAB

functions cannot be defined from inside a MS-Word document.

2.4 Notebook setup

Depending on whether or not you have “Administrator privileges” on your Windows machine, there are two
ways to set up the notebook functionality (which works in versions 5.x, 6.x and 7.x of MATLAB).

1. This easy setup works if your Windows account has administrator privileges: From inside MATLAB,
type notebook -setup, and follow the instructions given.4

2. In Bunger-Henry 216 (the ECE-2025 lab), MATLAB’s notebook feature is already installed. In order
to use it from MS-Word, you must:

(a) Open MS-Word and then go to the menu Tools->Macro->Security and select medium
instead of high. Click the OK button.

3In MATLAB 7 there is a new feature that allows you to publish MATLAB code to a Word document. We will not use this during
the lab, but an introduction to this new MATLAB feature has been written and is available as a link on Web-CT.

4Once the the setup is complete, click on the start menu and find the New Office Document option. Under the General
tab you should find m-book.dot. Click on it to start MS-Word. This might also start up MATLAB if it is not already running.
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(b) Then go to the File menu in MS-Word, and open the file m-book.dot which is in the folder
C:\Appl\MatlabR14\Notebook\PC\.
Note: If a “Security Warning” window pops up, click “Enable Macros” to proceed. Please ignore
the Microsoft Visual Basic error “Command Failed”, and press “End” to continue.

3. This harder setup works even for accounts with non-administrative privileges.

(a) Open MS-Word and then go to the menu Tools->Macro->Security and select medium
instead of high. Click the OK button.

(b) Now go to the File menu in MS-Word, and open the file m-book.dot which is in the folder5

C:\Appl\MatlabR14\Notebook\PC\.

(c) A dialog box comes up where you type the path to the matlab.exe file.
Type in C:\Appl\MatlabR14\Bin\win32\.

(d) MATLAB will start up and once it has loaded up, return to MS-Word and select the File menu
and pick New M-Book.

• Once MS-Word has opened a notebook document, there will be a new menu in MS-Word called
Notebook which enables a variety of functionality related to MATLAB.

2.4.1 Using MATLAB from MS-Word

Once the notebook capability has been installed you can start it by either: (1) typing notebook at the
MATLAB command prompt, or (2) clicking on the Start Menu -> Microsoft Office Tools
and finding the New Office Document option, under which you select m-book.dot from the General
tab.

• To verify that the notebook capability works, from inside MS-Word, type

varA = 1+1i - 6, and then press the Ctrl-Enter keys together.

This should give you MATLAB’s computed answer in the MS-Word document.

• To create a plot inside MS-Word, type the the line below (followed by Ctrl-Enter)
t=0:0.1:pi; y=sin(3*t+0.05); plot(t,y); title(’My First Plot’)

• To call one of your functions or MATLAB script files, just type in the name followed by Ctrl-Enter.
Built-in MATLAB functions are called in the same way, for example
[V,lam] = eig([1 2 3; 3 3 3; -1 2 3]) followed by Ctrl-Enter

• Take some time to investigate the other items and more advanced features under the Notebookmenu
that was installed in MS-Word. Additional help can be found in MATLAB by typing helpdesk and
searching for Notebook.

• If you dislike the way that figures get inserted inside MS-Word with a grey background, then you
can change to a white background by resetting one of MATLAB’s defaults. One way is to execute the
following at the beginning of the MS-Word document
set(0,’DefaultFigureColor’,[1 1 1]);set(0,’DefaultAxesColor’,[1 1 1]);

5The path to MATLAB might be different on your personal machine depending on where you installed MATLAB.
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2.5 Vectorization

The power of MATLAB comes from its matrix-vector syntax. In most cases, loops can be replaced with
vector operations because functions such as exp() and cos() are defined for vector inputs, e.g.,

cos(vv) = [cos(vv(1)), cos(vv(2)), cos(vv(3)), ... cos(vv(N))]

where vv is an N -element row vector. Vectorization can be used to simplify your code. If you have the
following code that plots a certain signal,

M = 200;
for k=1:M

x(k) = k;
y(k) = cos( 0.001*pi*x(k)*x(k) );

end
plot( x, y, ’ro-’ )

then you can replace the for loop with one line and get the same result with 3 lines of code:
M = 200;
y = cos( 0.001*pi*(1:M).*(1:M) );
plot( 1:M, y, ’ro-’ )

Run these two programs to see that they give identical results. Use the notebook capability to put the
plots into a MS-Word document.

2.6 Functions

Functions are a special type of M-file that can accept inputs (matrices and vectors) and also return outputs.
The keyword function must appear as the first word in the ASCII file that defines the function, and the
first line of the M-file defines how the function will pass input and output arguments. The file extension
must be lower case “m” as in my func.m. See Section B-6 in Appendix B of the text for more discussion.

The following function has several mistakes. Before looking at the correct one below, try to find these
mistake(s) (there are at least four):

matlab mfile [xx,tt] = badcos(ff,dur)
%BADCOS Function to generate a cosine wave
% usage:
% xx = badcos(ff,dur)
% ff = desired frequency
% dur = duration of the waveform in seconds
%
tt = 0:1/(100*ff):dur; %-- gives 100 samples per period
badcos = real(exp(2*pi*freeq*tt));

The corrected function should look something like:
function [xx,tt] = goodcos(ff,dur)
tt = 0:1/(100*ff):dur; %-- gives 100 samples per period
xx = real(exp(2i*pi*ff*tt));

Notice the word function in the first line, and the exponential needs to have an imaginary exponent. Also,
the variable freeq has not been defined before being used. Finally, the function has xx as an output and
hence the variable xx should appear in the left-hand side of at least one assignment line within the function
body. In other words, the function name is not used to hold values produced in the function.
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3 Warm-Up: Complex Exponentials

In the Pre-Lab part of this lab, you learned how to write function M-files. In this section, you will write two
functions that can generate sinusoids, or sums of sinusoids. Use MATLAB’s notebook capability to put
the plots into a MS-Word document when doing the Instructor Verifications.

3.1 Vectorization

Use the vectorization idea to write 2 or 3 lines of code that will perform the same task as the following
MATLAB script without using a for loop.

%--- make a plot of a weird signal
N = 200;
for k=1:N

xk(k) = k/60;
rk(k) = sqrt( xk(k)*xk(k) - 1 );
sig(k) = exp(j*2*pi*rk(k));

end
plot( xk, real(sig), ’mo-’, xk, imag(sig), ’go-’ )

Note: there is a difference between the two operations rr*rr and rr.*rr when rr is a vector.

Instructor Verification (separate page)

3.2 M-file to Generate One Sinusoid

Write a function that will generate a single sinusoid, x(t) = A cos(2π f t + ϕ), by using input arguments
for complex amplitude (X = Ae jϕ), frequency ( f ), duration (dur) and starting time (tstart). The
function should return two outputs: the values of the sinusoidal signal (x) and corresponding times (t) at
which the sinusoid values are known. Make sure that the function generates exactly 25 values of the sinusoid
per period. Call this function onecos(). Hint: use goodcos() from the Pre-Lab part as a starting point.
Plot the result from the following call to test your function.

[xx0,tt0] = onecos( [5*exp(j*pi/4)], [2], 2, -1); % (freq in Hz)

Use the notebook feature to make this plot inside a MS-Word document.

3.3 Sinusoidal Synthesis with an M-file: Different Frequencies

Since we will generate many functions that are a “sum of sinusoids,” it will be convenient to have a MATLAB

function for this operation. To be general, we will allow the frequency of each component ( fk) to be
different. The following expressions are equivalent if we define the complex amplitude Xk as Xk = Ake jϕk .

x(t) = <e

{
N∑

k=1

(Ake jϕk )e j2π fk t
}

(7)

x(t) =

N∑
k=1

Ak cos(2π fk t + ϕk) (8)

3.3.1 Write the Sum of Sinusoids M-file

Write an M-file called add cmplx exp.m that will synthesize a waveform in the form of (7) using Xk

defined in (3). Although for loops are rather inefficient in MATLAB, you must write the function with one
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outer loop in this lab. The inner loop should be vectorized. The first few statements of the M-file are the
comment lines—they should look like:

function [xx,tt] = add_cmplx_exp(Xk, fk, dur, tstart)
%ADD_CMPLX_EXP Synthesize sinusoid from sum of complex exponentials
% usage:
% [xx,tt] = add_cmplx_exp(Xk, fk, dur, tstart)
% Xk = vector of COMPLEX amplitudes
% fk = vector of frequencies (usually none are negative)
% dur = total time duration of the signal
% tstart = starting time
% xx = vector of sinusoidal values
% tt = vector of times, for the time axis
%
% Note: fk and Xk must be the same length.
% Xk(1) corresponds to frequency fk(1),
% Xk(2) corresponds to frequency fk(2), etc.
% The tt vector should be generated with a small time increment that
% creates 25 samples per period. Use the period corresponding to
% the highest frequency in the fk vector.

The MATLAB syntax length(fk) returns the number of elements in the vector fk, so we do not need
a separate input argument for the number of frequencies. On the other hand, the programmer (that’s you)
should provide error checking to make sure that the lengths of fk and Xk are all the same. See help
error.

3.3.2 Testing

In order to verify that this M-file can synthesize sinusoids, try the following test and plot the result in MS-
Word via the notebook capability.

[xx0,tt0] = add_cmplx_exp( [exp(j*pi/4),2i,-4], [12,9,0], 1, -0.5); %-Period = ?

Measure the DC value (which is also the average value) and also the period of xx0 on the plot. Then
write an explanation on the verification sheet of why the measured values are correct. Notice that when this
M-file is used to synthesize harmonic waveforms, you must choose the entries in the frequency vector to be
integer multiples of the fundamental frequency.

Instructor Verification (separate page)
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4 Lab Exercises: Room Reverberation

The quality of sound that we hear can be affected dramatically by the room in which we are listening. This
is a big issue in teleconferencing systems where the speech quality often sounds reverberant. Although it is
rather difficult to determine precisely (and completely) how a particular room might behave, we can exhibit
a frequency dependent quality with a simple “ideal room” scenario.

4.1 Source and Receiver Configuration

Consider an “idealized room” that contains a microphone that can hear a source signal (see Fig. 1). If the
source is near a reflecting wall, then the receiver hears the sum of two signals: the direct signal from the
source to the microphone and the reflected signal that travels from the source to the reflecting wall behind
and then from the wall to the receiver. Since the travel paths have different lengths, the two signals will
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Figure 1: Scenario for a reverberant room. Only one wall can reflect, and the signal is assumed to propagate
only along the horizontal direction. The absorbing walls are perfect, so no signal energy reflects from these
walls. The source is located 0.5 meters from the “reflecting wall” and the receiver is located 4 meters from
the source.

arrive at different times. The received signal, called r(t), is the sum of two delayed copies of the transmitter
signal s(t). Thus we could write

r(t) = s(t − td1) + s(t − td2) (9)

where td1 and td2 are the amount of time it takes for the signals to travel from the source to the receiver, and
s(·) is the transmitted (sinusoidal) signal.6 The travel times, td1 and td2 , can be computed easily once we
know the speed of sound and the locations of the source, the receiver and the wall.

4.2 Room Frequency Response

The goal in this part of the lab will be to produce a plot of the received signal amplitude versus frequency to
show that the shape of the room dictates what we hear as a function of frequency (this plot would be called
the room’s frequency response). In order to carry this out, we assume that the source signal (in Fig. 1) is a
sinusoid, vary the frequency of the source, and compute the amplitude of the signal at the receiver.

(a) The amount of the delay (in seconds) can be computed for both propagation paths. First of all,
consider the direct path from the source to the receiver. The time delay is the distance from the

6For simplicity we will ignore propagation losses. Usually, the amplitude of an acoustic signal that propagates over a distance
R will be reduced by an amount that is inversely proportional to R.
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transmitter location to the receiver (dsr = 4 meters), divided by the speed of sound which is assumed
to be c = 300 m/s (an approximate value). Write a mathematical expression for this time delay, which
will be called td1 .

(b) Now write a mathematical formula for the time delay of the signal that travels the path from the source
to the wall and then to the receiver. Call this delay time td2 and write a mathematical expression for it.
The distance from the source to the wall is dsw =

1
2 meter.

(c) Assume that the source signal s(t) is a sinusoid with a frequency of f = 1000 Hz; and also assume
that the complex amplitude of the transmitted signal is 3e jπ/5. Make a plot of the received signal, r(t)
along with the two delayed signals in (9). Use subplot. Plot only 3 periods of the sinusoids and then
measure the relative time-shift between the two received signals by comparing peak locations. Use 25
samples per period for the sinusoids. Compare to your calculations in parts (a) and (b).

(d) Repeat the operations of the previous part for a different frequency, f = 900 Hz. Measure the peak
amplitude of the output sinusoid that you will have in r(t). Compare to the peak amplitude obtained
in the previous part (at 1000 Hz), and comment on the difference.

(e) Describe how the calculation of peak amplitude in the previous two parts could have been done with
a single phasor addition of complex amplitudes. Show this complex amplitude calculation in your lab
report.

Note: The complex amplitudes for the two components at the receiver A1e jϕ1 and A2e jϕ2 can be found
by calculating the distances from the source to the receiver along each path, and using the speed of
sound (c = 300 m/s) to convert to time delay, which can then be converted to phase.

(f) The objective in the rest of this lab is to write a MATLAB function that will determine the peak
amplitude of the output for the range of frequencies: 0 ≤ f ≤ 1500 Hz. To do this, the delayed
signals should be manipulated as complex amplitudes, not as sinusoidal waveforms. The result of
your function should be two vectors: a list of frequencies and a list of peak amplitudes. These two
vectors can then be used to make a plot of peak amplitude versus frequency.
Vectorization: It is likely that your previous programming skills would lead you to write a loop to do
this implementation. The loop would run over all possible frequencies, one at a time. However, it is
possible to vectorize this program similar to what was done for the example in Section 3.1.

(g) It is possible to carry a mathematical analysis for this simple scenario. Therefore, derive a formula for
the peak amplitude as a function of frequency, and explain how it matches the plot that you produced
in the previous part.

(h) Use the peak-amplitude versus frequency plot to discuss how the room configuration affects the sound
at the receiver. For example, did you find frequencies where the received signal is larger that the source
signal, or where the received signal is zero? In addition, discuss what would happen if the source was
moved farther from the wall, e.g., one meter from the wall (keeping the source receiver distance the
same).
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Lab #2
ECE-2025

Spring-2005
INSTRUCTOR VERIFICATION SHEET
Turn this page in to your TA before the end of your lab period.

Name: Date of Lab:

Part 3.1 Replace the inner for loop with only 1 or 2 lines of vectorized MATLAB code. Write the MATLAB

code in the space below:

Verified: Date/Time:

Part 3.3.2 Show that your add cmplx exp.m function is correct by running the test in Section 3.3.2 and
plotting the result. Measure the DC value and the period of xx0 and explain why the measured values are
correct. Write your explanations in the space below.

Verified: Date/Time:

General: Use MATLAB’s notebook capability to create and save the plots when doing the Instructor Ver-
ifications. Show the MS-Word document to your TA.

Verified: Date/Time:
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